
 
 
A Guide to Northern Bottlenose Whale Photo ID  
 

 

 

Version 3.1 

Updated March 2021 
 

 

 

Laura Feyrer, Madison Stewart & Jasmine Yeung 

Northern Bottlenose Whale Project 

Dalhousie University 

  



 2 

Table of Contents 
Table of Contents ................................................................................................................................ 2 
Figures ................................................................................................................................................. 3 

INTRODUCTION TO NORTHERN BOTTLENOSE WHALE PHOTO-IDENTIFICATION ........... 4 

PART I: DATA MANAGEMENT AND MATCHING ..................................................................... 5 
Getting started with the NBW Project catalogue protocols in Lightroom ................................................. 5 
File Structure and Backups ...................................................................................................................... 6 
Dorsal Catalogues and Matching ............................................................................................................. 7 
Starting a New Annual Catalogue ............................................................................................................ 7 
Checklist for Adding Annual Catalogues to Master .................................................................................. 9 
Matching Workflow and Tips .................................................................................................................... 9 
The Biopsy Catalogue ............................................................................................................................ 11 
Quality (Q) Ratings for Dorsal Fin Photos .............................................................................................. 12 
Mark Type Keywords ............................................................................................................................. 14 

Reliable Markings .............................................................................................................................. 15 
Other Markings/Keywords Used for Identification .............................................................................. 17 
Anthropogenic-Caused Markings ...................................................................................................... 21 
Markings/Keywords Not Used for Identification ................................................................................. 23 

Photos with Multiple Whales .................................................................................................................. 26 
Lightroom Tips and Troubleshooting ..................................................................................................... 27 
Dealing with Photo ID Errors .................................................................................................................. 28 
Plug-Ins: List View and Transporter ....................................................................................................... 29 

List View ............................................................................................................................................ 29 
LR/Transporter ................................................................................................................................... 29 

PART II: GUIDE FOR MELON ANALYSIS ............................................................................... 31 
Screening Photos and Creating an Annual Catalogue .......................................................................... 31 
Linking Melons to Dorsal IDs ................................................................................................................. 31 
Q-Ratings for Melon Photos ................................................................................................................... 32 
Introduction to Northern Bottlenose Whale Melon Sex-Age Classification ............................................ 34 
Melon Sex-Age Classification Protocol .................................................................................................. 35 
Entering Sex Classification into Lightroom ............................................................................................ 38 
Annual Sex Summary by ID ................................................................................................................... 42 
The Melon Master Catalogue ................................................................................................................. 42 
Master Melon Sex Summary by ID ........................................................................................................ 43 
Incorporating the Melon Sex Summary into the Master Dorsal Catalogue ............................................ 43 
Checklist for Annual Melon Analysis: ..................................................................................................... 44 

REFERENCES ........................................................................................................................... 45 

APPENDIX 1 SCOTIAN SHELF CATALOGUE BINDER METADATA CODES BY YEAR ...... 46 

APPENDIX 2 LIST OF KEY TERMS ......................................................................................... 47 

APPENDIX 3 DISTINGUISHING PATCHES FROM SLOUGH SKIN ........................................ 48 

APPENDIX 4 LARGE SCAR RECLASSIFICATION ................................................................. 50 

APPENDIX 5 PROTOCOLS USED IN THE COMPILATION OF THE MASTER CATALOGUE
 .................................................................................................................................................... 51 

A. Film/Negatives and Scanning ............................................................................................................ 51 
B. Converting CR2 Files to JPEGs ........................................................................................................ 52 



 3 

C. Changing Capture Date/Time ............................................................................................................ 53 
 

Figures 
Figure 1. Northern bottlenose whale photo-ID protocol for importing dorsal and melon field data. ............. 7 
Figure 2. Dorsal fin Q-rating examples   .................................................................................................. 13 
Figure 3. Dorsal skirt surrounding the dorsal fin, where markings are considered for analysis ................. 14 
Figure 4. Back indentation .......................................................................................................................... 15 
Figure 5. Notch ........................................................................................................................................... 15 
Figure 6. Distinguishing between back indentations (BI) and notches. ...................................................... 16 
Figure 7. Large Scar ................................................................................................................................... 17 
Figure 8.  Circle scars ................................................................................................................................ 17 
Figure 9. Lamprey Cookie-cutter Shark (LCCS) ........................................................................................ 18 
Figure 10. Linear Scars .............................................................................................................................. 18 
Figure 11. Patches ..................................................................................................................................... 19 
Figure 12. Tooth rakes ............................................................................................................................... 19 
Figure 13. Unusual and unique markings ................................................................................................... 20 
Figure 14. Entanglement Scars .................................................................................................................. 21 
Figure 15. Propeller-vessel strike scars ..................................................................................................... 22 
Figure 16. Example of a "clean" whale ....................................................................................................... 23 
Figure 17. Diatoms ..................................................................................................................................... 23 
Figure 18. Fetal folds .................................................................................................................................. 24 
Figure 19. Lice ............................................................................................................................................ 24 
Figure 20. Skinny ....................................................................................................................................... 25 
Figure 21. Slough skin ................................................................................................................................ 25 
Figure 22. Identifying and labelling photos with multiple whales ................................................................ 26 
Figure 23. Adding or altering GPS coordinates using a plugin ................................................................... 30 
Figure 24. Melon Q-rating and example photos ......................................................................................... 33 
Figure 25. Photos of melon sex analyses classification and confidence ratings ........................................ 41 
Figure 26. Northern bottlenose whale with patch ....................................................................................... 48 
Figure 27. Northern bottlenose whale with sloughed skin .......................................................................... 48 
 

  



 4 

Introduction to Northern Bottlenose Whale Photo-Identification 

This guide focuses on using Adobe Lightroom to facilitate the photo identification of 
northern bottlenose dorsal fins and melons. It was developed in the process of 
integrating photos from a long-term photo-identification dataset of northern bottlenose 
whales (NBW) from 1988-2019, which included incorporating previous identifications, 
matching protocols, quality rating systems for film and digital photographs. This guide 
documents the protocols used for building the Master Scotian Shelf NBW catalogue and 
is intended to support ongoing matching and analysis of northern bottlenose whales. 
The document has been divided into two parts: 

Part I: Details the data management and workflows used in the creation of individual 
annual or regional dorsal catalogues, as well as updating and maintaining 
Master catalogues. Includes guidance on matching and keywording dorsal fins 
of individual northern bottlenose whales.  

Part II: Describes the process for building a melon catalogue and determining the 
sex of individual northern bottlenose based on their melon shape.  

 

The Guide to Northern Bottlenose Whale Photo ID is updated on an ongoing basis and 
the most current version can be found at: 
https://northernbottlenosewhale.weebly.com/our-publications.html 

 

 

Preferred citation for this guide:  

Feyrer, L.J., Stewart, M. & Yeung, J. 2021. A Guide to Northern Bottlenose Whale 
Photo ID. Version 3.1. Dalhousie University. 52 pages.  
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Part I: Data Management and Matching 
Getting started with the NBW Project catalogue protocols in Lightroom 

• We use the photo management program Adobe Lightroom to create digital 
catalogues to organize, edit, and match the photos of NBWs taken since 1988.  

• Lightroom is a database that does not store the photos, but instead stores the 
metadata about each photo. This information is stored in the catalogue as an 
.lrcat file. 

o If the photos are moved on the computer, the photos in Lightroom will be 
greyed out and/or have an exclamation mark on their thumbnails. The 
location will need to be updated in Lightroom by right-clicking on the 
parent folder and selecting “Find missing folder”.  

o To see all missing photos in the catalogue, go to Library > Find All Missing 
Photos. The photos will be placed in a collection (under Catalog) for easy 
access, until their location is found. 

• Lightroom allows the metadata of photos to be edited (filename, GPS, keywords, 
quality ratings, date, etc.). 

o The metadata can be saved to the photos through Lightroom BUT be 
careful, as metadata can be overwritten if saving from an outdated 
catalogue.  

• Dorsal fin photos taken since 1988 of quality 3 and 4 have been integrated into 
the Master Scotian Shelf catalogue. These photos have been matched across 
years and each individual whale has been given a unique ID number or name. 
Each ID has a “best of” photo (the best and most recent photo, if possible) that 
has been given the keyword “Overall Best of”. Any photos that have not been 
matched are given the title “unk” for unknown. UNK photos are not included in 
analysis and are largely of low quality, retained for legacy purposes only. 

o The Master catalogue name is: SS1988_20XXDorsalsMASTER (‘XX’ 
indicates the most recent year that has been added to the catalogue; see 
below for instructions for adding annual catalogues to Master). 

o Metadata should be saved regularly from the Master catalogue (or any 
other working catalogues) to ensure that no work is overwritten or lost 
(select photo(s), ctrl + S). This may take a while depending on the number 
of photos selected. 

o Left- and right-sided photos are treated as separate catalogues, such that 
the same whale may not have the same ID for its left and right sides.  

o The IDs are written in the “title” of the metadata for each photo. 
• The Master catalogue (and any other recently edited catalogue) should be 

backed-up regularly. Each catalogue should be set  to prompt a back-up once a 
week after closing the program. 

o Ensure that the backups are being saved to the correct folder (Click 
“Browse” to select folder location). 

o If you want to back up a catalogue immediately (i.e. before making big 
changes), go to Edit > Catalogue Settings > General, and set the drop 
down bar to “When Lightroom next exits”. Close Lightroom and the backup 
prompt will appear.  
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• The file name structure for all photos should be similar to: 
NBW_date_imagename.jpg. To rename photos (you can do this in bulk), go to 
Library > Rename Photos, then in the drop-down menu, go to Edit. Here you can 
customize the file names to have the date, which will be taken automatically from 
the photo’s metadata.  

o Cameras will automatically name photos with a prefix (i.e. IMG_). This 
prefix can be changed in the camera settings so that the photos are 
named after the initials of the PI working on the project.  

• Only one Lrcat file can be open at a time. If you try to open a second file, 
Lightroom will automatically close the catalogue you are working on.  

• If Lightroom is running slow, you may need to close the program and reopen it, or 
you can try File > Optimize Catalogue.  

 

File Structure and Backups 
• It’s extremely important to be diligent and consistent with file naming and 

structure on the computer/hard drive. Currently, each working catalogue should 
have a folder for the Lightroom catalogue(s), files, and associated photos, and a 
folder for datasheets or metadata files.  

• All catalogues should be clearly named, and the associated photos, previews 
and backups should be properly filed to ensure that Lightroom can access the 
files. If the catalogue file is moved to a new location on the computer, the photos 
will have to be moved as well, and you may have to point to its new location in 
Lightroom.  

• Any data sheets should be kept in the folder with the associated catalogue. It’s 
also important to ensure that regularly produced datasheets, such as ListViews 
(see page 28), should have the date it was created in the file name (e.g. 
LV_SSDorsalMaster_march23), and old versions should be archived or deleted.  

• The original catalogues and photos (pre-quality check) from each annual season 
should be archived on the backup drive, leaving only the working catalogue(s) of 
quality-rated and keyworded photos. Any old catalogues or files can also be 
archived to the backup drive and deleted from the main computer.  

• Keep track of versions so that data isn’t accidently deleted or overwritten from an 
outdated file!  
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Dorsal Catalogues and Matching  
Adding new datasets (>50 photos) to any catalogue should follow the guidelines 

below (see also Figure 1) for creating a new annual catalogue.  

 
Figure 1. Northern bottlenose whale photo-ID protocol for importing dorsal and melon field data. 

 

Starting a New Annual Catalogue 
With each new year of photos, a separate Lightroom catalogue is created to 

process and match the photos before adding them to the Master catalogue. 

1. Once imported into Lightroom, screen the photos that do not contain northern 
bottlenose whales or are very poor quality (i.e. photos of water or people, very 
blurry, etc.). These photos can be removed. You can also use keywords (i.e. 
NBW, other species).  

2. Add keywords to distinguish the body part visible in each photo (melon, dorsal fin, 
back). The dorsal fin photos can then be exported into a separate catalogue: 
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i. Select desired photos. 
ii. File > Export as Catalogue > Choose location on computer and name 

catalogue (ex: SS2013_dorsals) > OK 
iii. In drop down menu, select “move photos” (this is so the photos 

associated with this new catalogue are copied to the same location) 
3. Keyword any photo with more than one whale with “Multiple Whales”. Any photos 

with multiple whales of Q3 or higher must be cropped (see instructions below). 
4. Keyword the dorsal fin side (Left or Right) and the year for all photos.  
5. Quality rate all photos (see below for instructions and examples). If already done, 

the consistency of the ratings may need to be checked. 
6. Match photos within the season and give individual whales a unique ID (you can 

use any naming scheme you want because this is temporary, and the photos will 
be given master IDs eventually). Put the ID as the “Title” of the photo. 

i. The easiest way to do this is to start by matching whales for each 
encounter/day, and then match the whales across the field season. 

ii. Stacking is a useful tool for keeping track of individuals while you sort 
through photos. Select desired photos, right click, Stacking > Group into 
Stack. You can then close the stack in order to have only one photo of 
that individual visible and can add new photos as needed.  

7. Determine the best photo of each ID and keyword it with “best of”  
i. The chosen photo (ideally Q4) should show the most detail of scarring and 

include as much of the dorsal skirt as possible.  
ii. I recommend making a “Best of” Smart catalogue for these photos 

(separate for lefts and rights). 
8. Using the “best” photo as a guide, keyword mark types for all photos of each ID 

(see below for examples of mark types). 
9. Export “best of” photos to a new catalogue. Name it something like 

“year_bestof_matching”. This catalogue will only be used for matching, so any 
changes to the photos should be made in the original annual catalogue only.  

10. From the Master catalogue, export a catalogue of the “Overall best of” photos, 
then import this catalogue into the catalogue created in step 9. 

i. File > Import from Another Catalogue > Choose the desired .lrcat file > 
Choose location to move photos > Import 

11. Match the annual catalogue to the Master and record the IDs of all matches.  
i. You can make an Excel spreadsheet to track any changes you make and 

the list of matching IDs between the two catalogues.  
ii. Any whales that do not match the Master need to be given new IDs. Start 

from an ’00 number (6000, 6100, 6200, etc.) and continue numbering 
sequentially (6001, 6002, 6003, etc.).   

iii. Any individual with a very distinguishing notch and has both a left and 
right side can be combined into 1 ID. Otherwise, keep the left and right 
IDs separate.  

12. From the annual dorsal fin catalogue, export all Q3 and 4 photos to a new 
catalogue, then change the annual IDs of all photos to match the Master IDs. 

13. In the Master catalogue, import the photos from the step above, making sure to 
move the photos (double-check that the folder location is correct).  
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i. You can now delete the matching catalogs from steps 9 and 10, or archive 
them. 

14. Close the Master catalogue and change the names of the .lrcat, Previews, Smart 
Previews files (if applicable), and photos folder to include the recently added year 
of photos.  

i. i.e. SS1988_2010DorsalMASTER changes to: SS1988_2011… 
15. Update the “Overall Best” photo of each ID with the newly imported photos (only if 

new photo is of equal or better quality than the current “Overall best” photo). 
16. Remember to clean up any extra keywords and collections that may have been 

imported along with the photos.  

 

Checklist for Adding Annual Catalogues to Master 
□ Delete non-NBW photos from catalogue 
□ Keyword body part (dorsal fin, melon) 
□ Export dorsal fin photos to new catalogue. 
□ Process photos with multiple whales. 
□ Keyword year for all photos. 
□ Keyword left and right side for all photos. 
□ Quality rate all photos/check consistency of quality ratings. 
□ Match photos within field season. 
□ Keyword “best of” for best photo in each ID. 
□ Keyword mark types for each ID. 
□ Create matching catalogue of the “best of” from the annual catalogue and the 

“Overall Best of” from the Master catalogue. 
□ Match annual photos to Master photos. 
□ Change IDs of annual catalogue to match Master IDs. 
□ Import annual catalogue into Master (make sure to move photos). 
□ Rename Master catalogue and associated files. 

 

Matching Workflow and Tips 
For each annual or master catalogue, there should be Smart Collections (separate 

for lefts and rights) with the best photo of each ID across the entire sampling period. All 
photos in these collections can be exported into a temporary catalogue for matching, 
named according to the catalogues being matched (i.e. SS_NFLD_matching, 
SS_2019_Master_matching, etc.). The Smart Collections will automatically appear in 
the newly exported catalogue.   

• Depending on the analyses, only well marked* individuals will be matched. Well-
marked individuals have either a notch, a large fin or body scar, or a back 
indentation.  

 
 
*Note this is different than “Reliably marked” IDs which are only those IDs with a notch 
or back indent, used for scaling mark recapture population estimates. 
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As an example, the protocol below includes directions for matching one region (NFLD) 
to another (SS), however, the same protocol can be used to match annual catalogues to 
the Master.  

1. Open the Left NFLD smart collection and lock the first photo to the second 
monitor (right-click).  

2. Open the Left SS smart collection and, if needed, filter photos by mark type 
keywords. You can also make smart collections of SS photos with or without 
certain mark types (i.e. notch, no notch).  

3. Scroll to the very end (i.e. to the most recent photos), then go backwards through 
each photo in the collection to compare to the NFLD photo locked to the second 
monitor.  

4. As you go through each NFLD photo, write down its ID and any possible matches 
(you could also do this in Excel). This is also how to keep track of which photos 
have been matched.  

 
 
Important Matching Tips:  

• Keep in mind that whales can gain markings over time, so just because a 2017 
whale has a notch, it doesn’t mean it had a notch in 2016 or earlier! A Smart 
Collection of whales with “no notch” may come in handy in this situation.  

• Diatoms (brownish-orange patches), lice, and sloughed skin (greyish patches of 
peeling/peeled skin) are marking types that are not used for matching because 
they can change over days to weeks.  

• The shape of a fin can also be helpful for determining matches, but keep in mind 
that the angle of the fin to the camera may distort its shape as well as the shape 
of notch. 
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The Biopsy Catalogue 
• The biopsy catalogue includes information for biopsied individuals in all study 

regions across all field seasons.  
• For each biopsy sample, all photos of that individual from that field season are 

added to the catalogue and keyworded “biopsy”. The biopsy sample code is 
added to the caption of all photos.  

• Biopsy information is found from original field notes and datasheets. For each 
biopsy attempt, detailed information of the date, time, photo frames, whale 
reaction, and success of the biopsy is recorded. Using this information, photo(s) 
from the time of the biopsy can be used to determine the ID that was sampled. 
Ideally, the photo(s) will have the biopsy dart in the frame or evidence of a biopsy 
wound on the whale.  

• If the photo of the animal taken at the time of the biopsy is not great but can be 
used to locate a better photo of the same individual during another part of the 
encounter, both photos should be added to the biopsy catalogue. You may need 
to look through the original annual catalogue (all Q-ratings) in order to find photos 
from the time of the biopsy.  

• If a biopsied whale is not ID’ed (is “unk” in the master), the relevant photos 
should still be added to the catalogue and keyworded as usual.  

• Once all biopsy photos are keyworded, export a List View of the catalogue then 
use LR/Transporter to import the biopsy keyword into the Master catalogue using 
the filename as the guide.  
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Quality (Q) Ratings for Dorsal Fin Photos 
• Each photo in the catalogue must receive a quality (Q) rating based on the: 

o Focus 
o Angle of fin/body  
o Amount of fin visible 
o Exposure  

• Q ratings are not determined by how reliably marked a whale is (to reduce bias 
toward highly marked whales). 

• We currently use a 4-point scale to determine quality, with 1 being poor and 4 
being excellent.  

 

Q4 – Photos are well-lit and in focus, the fin is parallel to the observer (90°), and the 
entire fin at least the majority of the body surrounding the fin (one fin-width away) is 
visible. 

• Q4 photos show the most detail and are the most reliable photos for analysis, 
matching and identification. 

Q3 – Photos are good but lack one or two key criteria from Q4 photos (too dark, water 
splashes, out of focus, blurry, poor angle, fin not entirely in frame, etc.). 

• Q3 photos show some detail but may not be as useful for matching/identification. 

Q2 – Photos are generally poor, but whales may still be identifiable, however fine details 
are lost.  

• Photos are often very blurry and/or out of focus, the fin is almost entirely covered 
in water, the angle is poor (i.e. whale is swimming towards or away from camera) 

Q1 – Photos are very poor, and whales are usually completely unidentifiable. May 
include only a tip of a fin, be completely out of focus or the whale is too far away.  

***Photos of Q1 and 2 are removed from the Master catalogue, so distinguishing 
between the two is not as important as for Q3 and 4 photos. 
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Q-Rating Example Reasoning 

1 

 

- Completely out of 
focus and blurry 

- Not enough of body 
showing 

 

2 

 

- Too far away, grainy 
image 

- Water covering part 
of body 

- Backlit, reduces 
visibility of markings 

3 

 

- Image slightly soft in 
focus 

- Water covering part 
of body within 1 fin 
width from dorsal 

- Whale perpendicular 
to observer 

- Good lighting 
 

4 

 

- Image in focus 
- Radius of 1 fin width 

(approx) from dorsal 
is in frame 

- Whale perpedicular 
to observer 

- Good lighting 
  

 

Figure 2. Dorsal fin Q-rating examples   
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Mark Type Keywords 
• Mark type keywords are given to each ID in each year separately. This is to 

account for mark change or gain over time. The “best of” photo is used as a 
guide to add keywords to all other photos of that ID for that year.  

• Markings must be within one fin width from the base of the dorsal fin, called the 
“dorsal skirt”, to be counted and keyworded (Figure 1).  

• A single marking can be counted in multiple categories (i.e. circle + LCCS; linear 
+ tooth rake + large body scar; etc.) 

• Some markings are more reliable for photo ID and will persist for years, such as 
notches and back indentations (Feyrer et al., 2021; Gowans and Whitehead, 
2001). Whales with these mark types are considered “reliably marked” and may 
be prioritized for analysis and identification. 

• Diatoms (see below) and other short-lived markings are only useful for within-
year or even within-month identification and matching.  

 

 
Figure 3. Dorsal skirt surrounding the dorsal fin, where markings are considered for analysis 
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Reliable Markings 
• These mark types are permanent or will persist over long timescales. 

Identification of whales with these markings is easier and more reliable.  

Back indentation – Indentation or notch along the spine of the whale; Can be posterior 
or anterior (rare) to dorsal fin; Depth of the indentation may vary from small nicks to 
large gashes.  

 
Figure 4. Back indentation 

 

Notch – Any dorsal fin notch or where a chunk of fin has been removed; includes very 
small nicks as well as severe fin mutilation; White scarring may occur around edges; 
Notches are permanent and will not grow back.  

 
Figure 5. Notch 
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To distinguish between back indentations (BI) and notches: 

• Where the fin stops curving and the spine continues straight, all injuries above 
this are considered notches and below are back indentations (applies to the 
posterior and anterior dorsal).   

• If an injury spans this area, then it is considered both a notch and a back 
indentation.  

 
Figure 6. Distinguishing between back indentations (BI) and notches. 
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Other Markings/Keywords Used for Identification  
 

Large Body Scar – Highly identifiable scar or distinct marking on the body (within the 
dorsal skirt); to be considered “large”, the size of the mark (or group of markings, 
collectively) must be equal to at least 25% of the dorsal fin area 

Large Dorsal Scar – Highly identifiable scar or distinct marking on the dorsal fin or near 
the base of the dorsal fin; to be considered “large”, the mark (or group of markings, 
collectively) must span at least 25% of the fin 

 
Figure 7. Large Scar 

* Large scars will vary in shape, type and cause; generally white to grey in colour 

 

Circle – Any circular marking(s) (very common) 

 
Figure 8.  Circle scars 
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LCCS – Scar caused by lamprey or cookie cutter shark; usually circular donut shape 
with small teeth marks 

 

 
Figure 9. Lamprey Cookie-cutter Shark (LCCS) 

 

Linear – Any linear scars; white to grey in colour; will vary in length and thickness 

 
Figure 10. Linear Scars 
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Patch – Large blotchy white patches of various shapes, usually on the body of the 
whale; similar to a birth mark. *Not to be confused with sloughed skin, which are 
irregular in shape and change rapidly 

 
Figure 11. Patches 

 

Tooth rake – Two or more parallel, thin linear scars caused by the teeth of other 
animals; likely caused by other species of beaked whale, rather than other NBWs 

 
Figure 12. Tooth rakes 
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Unusual mark – Markings or scars that are very unique and difficult to classify 

 
Figure 13. Unusual and unique markings 
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Anthropogenic-Caused Markings 
• These keywords characterize a scar or grouping of scars that are assumed to be 

caused by interactions with vessels or fishing gear. Some severe marks (e.g. 
mutilations, amputations, back indents) may be difficult to distinguish as being 
caused by one or the other source. 

• Anthropogenic injuries on NBW have been characterised based on studies of 
other cetacean species and from analysis of photographs of other entangled 
beaked whales in the Gully (i.e. Sowerby’s). See Feyrer et al. 2021 for 
references and details. 
 

Entanglement – Usually thick, linear furrows that appear to wrap around the body or fin 
and may crisscross; may also have a back indentation, fin notch or protruding scar 
tissue in same location; can have breaks in linear pattern due to the whale’s body 
curvature, knotted lines. 

  
Figure 14. Entanglement Scars 

 

Propeller vessel-strike – Various injuries or scars assumed to be caused by a 
propeller or vessel strike, including large gashes, mutilated dorsal fins, and deep back 
indentations.   
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Figure 15. Propeller-vessel strike scars 
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Markings/Keywords Not Used for Identification 
• These mark types can change rapidly within a season and cannot be used to 

identify individuals long-term. They may be useful for matching within 
encounters. 

 

Clean – Given to any whale lacking any distinguishing or large markings (i.e. may only 
have small circle and/or superficial linear scars) 

 
Figure 16. Example of a "clean" whale 

 

Diatoms – Brown patches caused by diatoms; Change shape rapidly 

 
Figure 17. Diatoms 
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Fetal Folds – Creases on the skin of calves; will fade over time as the juvenile ages 

 
Figure 18. Fetal folds 

 

Mites/lice – Small, white crustaceans usually found near the tip of the dorsal fin 

 
Figure 19. Lice 
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Skinny – Whales that appear thin, with prominent ribs and/or back bone, scalloped 
spine and shadows on the body 

 
Figure 20. Skinny 

  

Sloughed skin – peeling skin on the body or fin; changes rapidly, not used for 
identification. *Not to be confused with patches, which are permanent and blotchy or 
mottled 

 
Figure 21. Slough skin 
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Photos with Multiple Whales 
• Photos with multiple whales must be cropped outside Lightroom so that each whale 

has a separate photo. Only whales of Q3 and higher need to be cropped.  
• The original photo is kept in the catalogue after the crops are imported. 
• Before beginning, make sure all photos with multiple whales (even without dorsal 

fins) are keyworded with “multiple whales”.  
• Recommended to make a collection of photos that need to be cropped for easy 

access while you work.  
 

1. In file explorer, go into the photos folder for the annual catalogue, then create a 
new folder and name it “crops” (or “multiples”). 

2. In Lightroom, right-click on a photo and select “Show in Explorer”. 
3. Copy then paste the photo in the new folder you created.  
4. Rename this newly pasted photo with an “a” after the file name (i.e. 

NBW_IMG1234a).  
5. Double-click on the photo to open, then click “Edit & Create” and “Edit”. 
6. Click on “Crop and rotate” and crop around the first whale. 

i. Whales are numbered (a, b, c, …) from left to right or from front to back, 
depending on the photo. 

7. Click “Done” then “Save” (NOT “Save as a copy”). 
8. Repeat the process until all whales in the photo of Q3+ have been cropped. 
9. Once all photos with multiple whales have been cropped, the folder containing the 

photos must be synchronized in Lightroom (right-click > Synchronize folder). This 
will then prompt you to import the photos.  

10. After importing, select all the cropped photos and keyword them “crops”. 
11. Give a purple label to the original photos with multiple whales and give them the 

title “see crops”.  

 
Figure 22. Identifying and labelling photos with multiple whales 
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Lightroom Tips and Troubleshooting 
• Using a second monitor can be very useful for matching photos. Right click on a 

photo, then select “Lock to Second Monitor”. You can then toggle the second 
monitor on/off by using the icon in the bottom left corner. If you don’t have a 
second monitor, you can also compare 2 photos side-by-side on one screen, 
using Compare View (XY icon in bottom toolbar).  

• Right-click on a photo then select “Show in Explorer” to open the photo from its 
location on the computer. 

• Lightroom filtering (top toolbar) allows you to search for photos based on certain 
metadata, such as rating, keywords, label colour, title/ID, date, etc.  

o In addition to searching for specific photos, this can be helpful for 
matching, checking consistency of quality ratings, ensuring completeness 
of metadata, etc.  

• Try to focus your efforts on the Q4 photos first, as they are usually the only 
photos used in population analyses. 

• Use control + A to select all photos. You can also invert your selection under 
Edit>Invert Selection. Use control + D to deselect photos.  

• Collections, Quick Collections and Smart Collections are powerful tools to sort 
photos for editing or matching: 

o Collections: Select desired photos then click the “+” in the Collections 
toolbar. You can also drag desired photos into the collection.  

o Quick collections: Located in the Catalog toolbar; to add a photo, simply 
click the open circle on the top right of its thumbnail. The circle will turn 
grey when the photo is added to the Quick Collection. Only one Quick 
Collection can be made at a time, however, it can be saved as a 
Collection or cleared by right-clicking.  

o Smart Collections: Smart Collections use rules to automatically add 
photos based on chosen criteria. Click the “+” in the Collections toolbar, 
click Create Smart Collection, then add rules in the pop-up box. Rules can 
sort for Keywords (under “Other Metadata”), Date, Rating, etc., and can 
either include or exclude these criteria. Double-click on an already made 
Smart Collection to edit the rules. Smart Collections have been made for 
every ID in the catalogue. 

• If a photo is too dark/bright, you can change the exposure in Quick Develop (right 
sidebar). If needed, click the black triangle to drop down more options for photo 
editing, such as contrast, highlights, shadows, etc. These adjustments are non-
destructive so they will not change anything on the original file.  

• If Lightroom turns black and the photos seem to be “floating”, press L to return to 
regular mode.  
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Dealing with Photo ID Errors 
• You may encounter errors in the photo identification catalogue, which may be 

caused by data entry errors or by poor matching. Often, two or more dorsal fins 
can look very similar (i.e. same sized notch in same place), so make sure to 
zoom in on photos and carefully scan the whole fin/body area to compare 
markings.  

• Any errors must be recorded in the Master Error Log Excel spreadsheet (or if in 
an annual catalogue, in the error log for that year). The subsequent correction(s), 
date corrected, number of photos affected, and any other information should also 
be recorded.  

• Photos with errors must be labelled red in Lightroom.  
• There are 3 main types of errors: 

a) Photos in the wrong ID – Any photo(s) that do not match the rest of the 
photos in the ID. Label the photos in red (to indicate an error) and match 
to the correct ID. If the photo(s) don’t match any other IDs, a new one will 
have to be created (starting in the 9000s to reduce confusion).  

b) Duplicate IDs – Individual whales with more than 1 ID. Photos must be 
moved to the oldest or original ID (i.e. lowest number). After moving the 
photos, make sure there is only 1 “Overall best of” photo in the original ID.  

c) Multiple whales in same ID – If an ID has more than one whale ID’ed to it 
(usually happens when two whales look very similar), the original 
individual will have to be determined. It may not always be obvious which 
whale is the original, so you may need to dig through old negatives and 
metadata files. All other individuals should be moved to the proper ID(s). 

• Corrections of Q4 errors should be prioritized, then Q3, and errors of Q1 and 2 
can be ignored.  
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Plug-Ins: List View and Transporter 
We use 2 plug-ins to bulk import and export metadata between Lightroom and Excel.  

• If plug-ins are not installed, follow these steps: 
1. Download from these links:  

https://www.photographers-toolbox.com/products/jbeardsworth/listview/ 
https://www.photographers-toolbox.com/products/lrtransporter.php 

2. Move the downloaded plug-in(s) to a folder of your choosing (but don’t 
delete them even after enabling the plug-ins in Lightroom). 

3. In Lightroom, go to File > Plug-in Manager 
4. Click “Add” and find the plug-in download.  
5. Enter the registration code (ask your supervisor for this), then click 

“Enable”. 
 

List View  
Exports data from Lightroom and provides a metadata summary in Excel for all or 
selected photos. Used to export metadata for analysis, for error checking or checking 
for missing metadata. 

1. Select desired photos or set a filter. 
2. In Lightroom, go to Library > Plug-in Extras > List View, Standard View (this may 

take a few seconds to load, depending on how many photos you choose). 
3. Choose desired metadata to export by clicking on the triangle of each column. 

4. Click the green icon  . This will open an Excel document with your metadata 
(may take a few seconds).  

5. Save as an Excel document and name accordingly.  

Ensure that the date each List View was created is written in the file name, so that older 
sheets of the same type can be archived or deleted.  

LR/Transporter  
Allows metadata to be imported to photos in Lightroom from an Excel sheet (CSV).  

1. Save a copy of your desired Excel sheet as a CSV file.  
2. In Lightroom, go to Library > Plug-in Extras > LR/Transporter, Import Metadata 
3. In Browse, choose the CSV file to extract metadata from.  
4. In Record Mapping, choose the field in Lightroom that the Transporter will look 

for (usually filename) and choose the corresponding metadata field from your 
CSV file.  

a. Check if your CSV file has the .jpg at the end of the filename or not. If it 
doesn’t, make sure to select filename w/o extension as the Lightroom 
field.  

5. In Fields Mapping, choose the metadata that you would like to import and the 
name of the field in Lightroom it will be sent to. Choose “overwrites if data source 
isn’t empty” in drop down menu.  

6. If desired, click the “+” to add more metadata fields to import. 
7. Click OK.  
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As an example, if you wanted to import GPS (both lat and long), you would set up 
Transporter with the following settings: 

 
Figure 23. Adding or altering GPS coordinates using a plugin 

**Note: GPS information cannot be imported if the GPS field is blank. You must fill in a 
temporary GPS first (i.e. something easy to distinguish, like 55’ 55’ 55 N) then import 
with Transporter. 

Another use for these plug-ins is to help fill in missing metadata in bulk. For example, 
any photos with blank IDs need to be given “unk” (unknown) as the title. Since blank 
titles cannot be searched for in Lightroom, using the plug-ins is more efficient than 
searching manually through the catalogue.  

1. Export a List View of desired photos (i.e. an entire catalogue).  
2. Fill in any blanks in Excel.  
3. Convert the Excel sheet to CSV then reimport the metadata using Transporter.   
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Part II: Guide for Melon Analysis  
Screening Photos and Creating an Annual Catalogue 

Screening melon photos can occur while screening dorsal photos, as it is more 
efficient for overall catalogue development. However, the dorsal catalogue is sometimes 
prioritized for analysis and including additional keywording of melon photos will require 
more time at the screening stage, so the starting point for compiling the melon 
catalogue may differ based on project priorities. The first steps for compiling a melon 
catalogue are outlined below. Melon catalogue development beyond screening depends 
on the completion and analysis of the dorsal catalogue for the year. 

1. Sort photos by filename so that the sequences are in order (especially if more 
than one camera was used in a field season) 

2. Review original field season catalogue (all Q-ratings) and keyword all melon 
photos and possible dorsal sequence links as ‘melon’. Dorsal link photos include 
all consecutive photos of the back and dorsal fin that follow the melon photo(s) of 
the individual, and should be in the same orientation and occur within a 30sec 
time window. 

3. Using the caption field, assign a temporary melon ID (e.g. Melon_1, Melon_2) to 
each melon-dorsal sequence. Temporary IDs should be added to the caption for 
ALL linked photos (melon, back and dorsal fin).  

4. Extract all melon photos and linked sequence/dorsal photos into a separate 
MELON_YYYY catalogue. 

5. Once all melons and linked dorsals are imported to a new catalogue, make sure 
the keywords for body part (melon, dorsal, back) and side (left/right) are 
complete for all photos. 
 

Linking Melons to Dorsal IDs 
Once Dorsal IDs for the annual catalogue are established, the relevant information 

from the dorsal master catalogue can be imported into the Melon catalogue so that only 
the melons with links to high quality dorsal IDs are further processed. 

1. Use a ListView .csv export of the dorsal catalogue to import the Q-rating 
information and unique Dorsal IDs in the Title field for the dorsal photos based on 
filename. 

2. Assign Dorsal IDs to all linked melon photos based on the temporary melon IDs 
and dorsal links. This can be done a few ways, but one method is to: 

• Export a ListView .csv of the melon catalogue. 
• Using Excel, filter the Caption field for each melon link ID, copy and fill the 

Dorsal ID for all melon linked photos in the Title field. 
• Import the updated Title field back into the melon catalogue using the 

Transporter plug-in in Lightroom. 
3. Keyword all photos with dorsal IDs with ‘master’ so that they can be filtered later. 
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Q-Ratings for Melon Photos 
Melon Q-rating is independent of the Q-rating of the dorsal fin or sex and is based 
primarily on proportion of melon that is visible. Unlike the Dorsal Master catalogue, 
photos of all Q ratings (as long as they are part of a sequence) will be included in the 
Melon Master catalogue.  

Melon Q-rating scale: 

• 4 stars: the entire melon is visible; water line is no higher than just above the 
beak 

• 3 stars: at least half the melon is visible 
• 2 stars: most of the melon is obscured but the rounded edge of the melon is still 

visible 
• 1 star: the melon is not visible (back photo, etc.) 

When the orientation of the whale is not perpendicular (90˚) to the observer, it can 
significantly affect sex analysis.  After visibility the Q-rating should be adjusted to 
account for orientation so that: 

• one star is deducted when the photo is between 45˚-70˚ to the body of the animal  
• two stars are deducted when the photo is at an angle < 45˚ 
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Q-rating Example 

1 

 

2 

 

3 

 

4 

 
Figure 24. Melon Q-rating and example photos 
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Introduction to Northern Bottlenose Whale Melon Sex-Age Classification 
Sex analysis described in detail below should be conducted on every melon 

photo linked to an identifiable dorsal with an ID. Gowans et al. (2000) was the first to 
formalize the method for sexing of northern bottlenose whales by photographic analysis 
based on qualitative descriptions for a dataset of 20 whales over 9 years. They relied on 
a subjective assessment of the relative “roundness” of the melon to classify a whale into 
one of three age/sex classes: female/juvenile, subadult male, or mature male. They 
tested this method using genetic determinations from 10 biopsied whales and found 
100% agreement with their classifications. However, Gowans (2000) did not have a 
genetic comparison for their subadult whale category. As a result of inconsistencies in 
the sub-adult male classification (see Yeung 2019 Honor’s thesis for further details), the 
protocol for sexing northern bottlenose whales has been revised and is based on two 
primary classifications: either: Mature Male (MM) or Female/Juvenile (FJ). Potentially 
the subtleties of this category could still be applied to the analysis of a chronology of 
individual males with multiple years of photos.  

The current methods established for sex analysis are described in the step-by-
step decision tree protocol. Using keywords in Lightroom, the sex classifications are 
summarized annually by ID (Sex_Sum), then summarized over the entire study period 
by ID (MelonMasterSex), and finally validated to biopsy sex, if applicable (Sex.Final).  

 

 

  



 35 

Melon Sex-Age Classification Protocol 

1. Is the melon round or flat? 
a. Very flat: Mature Male 

 

b. Very round: Female-Juvenile 

 
 

b. Difficult to tell: Go to Step 2 
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2. Where does the melon begin to round or flatten out? 
a. Halfway between the blowhole and the front of the melon or closer to 

the front:  
Mature Male 

 
 

b. Closer to the blowhole than the front of the melon:  
Female-Juvenile 

 
 

c. Difficult to tell: Go to Step 3 
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3. Draw a line from the point where the melon begins to round out to where the melon 
meets the beak (if visible), or the waterline. What does the melon contour look like? 

a. A sharper contour where the peak is closer to the top of the melon:  
Mature Male

 
 

b. A smooth parabolic contour where the peak is near the midpoint or 
closer to the beak:  
Female/Juvenile 
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Entering Sex Classification into Lightroom 
• Sex classification/rating codes are: Mature Male (MM), Female/Juvenile (FJ), or 

Unknown (UNK)  
• The sex classification is associated with a reviewer confidence rating: 2- not 

confident, 3- fairly confident, 4- very confident. This results in a combined 
confidence classification such as MM2 for a male whale that has low certainty or 
F4 for a female-juvenile with high certainty.  

• The sex classification-confidence rating for each photo is identified using the 
following keyword hierarchy (see below for example photos): 
 

i. Female-Juvenile 
a. Calf 
b. F2 
c. F3 
d. F4 

 
ii. Male 

a. MM2 
b. MM3 
c. MM4 

 
iii. Unknown – UNK 
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Sex Confidence 
Rating Example 

Calf 

 

F2 

 

F3 
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Sex Confidence 
Rating Example 

F4 

 

MM2 
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Sex Confidence 
Rating Example 

MM3 

 

MM4 

 
Figure 25. Photos of melon sex analyses classification and confidence ratings 
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Annual Sex Summary by ID  
After all melon photos in the annual catalogue have been analysed, the sex 
classifications are summarised by ID for the year. This is done by filtering the catalogue 
by Dorsal ID and assessing all melon photos of the individual from that year to identify 
the most likely overall sex classification based on best quality photos and/or the majority 
of consistent photos.  

The sex summaries can then be added to all photos in the annual melon catalogue as 
keywords using the following hierarchy: 

Sex_Sum 
a. Sum_M 
b. Sum_F 
c. Sum_Unk  

 

The following decision tree can help when summarizing sex for an ID: 

a. One or more photos MM3 or MM4  à    Sum_M 
One or more photos FJ3 or FJ4  à  Sum_F 

b. All photos MM2 or Unk AND Q3 or 4  à  Sum_M 
All photos FJ2 or Unk AND Q3 or 4  à  Sum_F 

c. All photos MM2 or Unk AND Q1 or 2  à  Sum_Unk 
All photos FJ2 or Unk AND Q1 or 2  à  Sum_Unk 

d. All photos Unk     à  Sum_Unk 
e. Mix of MM and FJ photos   à  Re-analyse 

 

The Melon Master Catalogue 
The melon master catalogue contains all the sex designations based on previous melon 
analyses and will be updated based on information from each new annual melon 
catalogue. Importing the information from the annual catalogue into the master should 
only be done when the annual catalogue has been fully analysed, all metadata has 
been saved to the photos, and the catalogue is considered final. The following steps are 
suggested to help streamline the incorporation of annual melon analyses into the Melon 
Master and dorsal catalogues. 

1. Select all photos in the annual catalogue and save metadata.  
2. Filter annual melon catalogue by the keyword “master” to identify all melons with 

a dorsal link and export as the annual [YYYY]_Master catalogue, saving a copy 
with photos in a new location. 

3. Open the Melon Master Catalogue in Lightroom and import the annual melon 
master from another catalogue - Import > navigate to the [YYYY]_Master 
catalogue 
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4. File Handling: Copy new photos to a new location and import 
5. Rename photos folder to [YYYY] 
6. Export a list view CSV of the Melon Master catalogue. 

 

Master Melon Sex Summary by ID 
After importing the newest annual catalogue, the master sex for each ID in the master 
melon catalogue needs to be re-evaluated based on the new sex classifications. The 
following steps have been used to do this: 

1. Using the CSV of the annual master melon catalogue, recode the sex summary 
for the IDs in the caption variable: 
a. For all new dorsal IDs: 

• Master Melon Sex will be equal to the summary from the annual sex 
classification. 

b. For IDs with previous sex summaries: 
• If the annual sex classification matches previous master sex, then 

stays the same 
• If the annual sex classification does NOT match previous master sex, 

evaluate: 
i. If biologically possible? (i.e. FJ transitioning to MM) 

- YES: recode master sex for ALL YEARS to the new sex 
classification 

ii. If there is photo quality or other issues? 
- Evaluate possible dorsal link or classification errors, record the 

issue, reassess, and reclassify the sex in the annual Melon and 
Master Melon catalogues 

2. Use Transporter to import updated sex CSV for all melon photos back into 
Master Melon catalogue. 

 

Incorporating the Melon Sex Summary into the Master Dorsal Catalogue 
Once the melon master catalogue has been finalized, the updated sex information 
needs to be imported into the dorsal catalogue.  

1. Export a CSV of the Melon Master catalogue 
2. Summarize the master sex for each ID (in Excel or R)  
3. Remove all previous melon sex keywords from photos in the dorsal catalogue 
4. Use Transporter plug-in to import the new Melon Master Sex keywords into 

the dorsal catalogue by appending the FJ, MM, or UNK variable as keywords.  
5. Update the Sex.Final keyword with the new melon sex 

a. If genetic sex (‘Male’, ‘Female’) is present for an ID it should be 
prioritized over melon sex in analyses.  
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Checklist for Annual Melon Analysis: 
□ Keyword ‘melon’ for all melon photos + dorsal sequences 
□ Assign temporary IDs to each sequence 
□ Export annual melon catalogue 
□ Check keywords for side and body part 
□ Import dorsal IDs and Q-ratings to dorsal photos in annual melon catalogue 
□ Assign dorsal IDs to linked melons for each sequence 
□ Keyword ‘master’ to all photos given a dorsal ID 
□ Q-rate all photos of melons 
□ Assign sex-age class and confidence rating to each ID’ed melon 
□ Summarize sex for each ID within the year 
□ Import annual catalogue into Melon Master catalogue 
□ Summarize sex across all years 
□ Import melon sex keywords into Master Dorsal catalogue 
□ Update Sex.final keyword 
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Appendix 1 Scotian Shelf Catalogue Binder Metadata Codes by Year 
 

YEAR PHOTO TYPE FILM 
ROLL/PHOTO 
CODE(S) 

# PHOTOS 
IN MASTER 
LRCAT 

1988 FILM A 27 
1989 FILM GU 683 
1990 FILM ID, SP 1768 
1991 FILM D 3 
1993 FILM UG 317 
1994 FILM GX 206 
1995 FILM BW 48 
1996 FILM AA, AB 1150 
1997 FILM SA 1013 
1998 FILM BA, GBW 1781 
1999 FILM JA 1081 
2001 FILM WM, WMS 316 
2002 FILM, DIGITAL TW 974 
2003 FILM, DIGITAL MD, LB 188 
2005 FILM GULLY 2 
2006 FILM MPA 309 
2007 DIGITAL BAL 58 
2008 DIGITAL TEM 17 
2009 DIGITAL NED 2 
2010 DIGITAL / 1136 
2011 DIGITAL / 2546 
2013 DIGITAL / 1031 
2015 DIGITAL / 3499 
2016 DIGITAL / 9496 
2017 DIGITAL / 717 
2019 DIGITAL / 2796 

 

 

 

 

 

 

 

 

 



 47 

Appendix 2 List of Key Terms 
 

Dorsal – the fin on the whale’s back; used for identifying individual whales 

Lightroom Catalogue – file that organizes photos and allows non-destructive changes to 
metadata  

List View – a spreadsheet exported from the Lightroom catalogue (using the Listview 
plug-in), listing every photo’s filename, title (ID), caption, keywords, date, time, 
GPS coordinates, and any additional metadata necessary 

Melon – the head of the whale, the shape of which is used for sex analysis 

Q-rating – “Quality Rating” of a photo used to determine which photos are used for 
analysis; dorsal and melon photos have different q-rating criteria 

Smart collection – a function in Lightroom that selects photos based on criteria, such as 
rating, keywords, title, date, etc.  

Type Specimen / Best of – the “best” photo of a particular ID, can be determined by 
year and by entire study period 
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Appendix 3 Distinguishing Patches from Slough Skin 
Since Gowans et al. (2001) it has become clear that the marking keyword for 

mottled patches was vaguely described, resulting in incorrect keywording of other 
marking types. The most common of these incorrect markings was sloughed skin, which 
is the peeling of dead skin, which can be seen in other cetacean species, such as 
sperm whales. Mottled patches are characterized by a white and blotchy appearance, 
usually on the body of the whale, and are usually large in size (Figure 26). Conversely, 
sloughed skin is greyish in colour and can be found anywhere on the body or fin of the 
whale. It is found in irregular shapes and can range in size (Figure 27). Digital resolution 
and colour images allow for easier distinction between these two marking types.  

 
Figure 26. Northern bottlenose whale with patch 

 
Figure 27. Northern bottlenose whale with sloughed skin 

An important difference between mottled patches and sloughed skin is that 
patches persist over time, allowing identifications across sampling years, whereas 
sloughed skin can rapidly change within a sampling season and even between days as 
the skin heals. Along with all mark type keywords, the patch keyword has been checked 
for mistakes, and the sloughed skin keyword has been introduced. Table 1 summarizes 
the number of IDs with the patch and sloughed skin keywords before and after the 
corrections.   
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Table 1. Number of IDs for left and right sides of the Scotian Shelf catalogue before and after rectifying the 
marking type keyword for patch in Lightroom.  

 Number of IDs 
Left  Right 

Original with 
Patch 

113 110 

Updated with 
Patch 

74 92 

Updated with 
Sloughed Skin 

56 41 
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Appendix 4 Large Scar Reclassification 
Previous northern bottlenose whale photo-identification work by Gowans & 

Whitehead (2001) characterized large scars as white, irregular shapes of >10 cm in 
size. This classification does not clearly define how the 10cm was measured or 
standardized across all photographs. Scars were reviewed and reclassified to better 
account for differences in fin size (juvenile vs. adult) and distance from camera, such 
that a scar or group of scars were considered large if spanning at least 25% of dorsal fin 
area. For keywording in Lightroom, large scars were classified separately for the dorsal 
fin and body (i.e. “Large Body Scar”, Large Dorsal Scar”). All photos with the keywords 
used for the original large scar classification were reviewed iteratively by ID and year, 
and the new keywords were added where appropriate. The ID summary for large scar 
keywords before and after re-classification is outlined in Table 2.  

 
Table 2. Number of unique IDs with each associated keyword. IDs counted separately for the left and right 
side photographs of whales. 

Large scar classification  Dorsal scar Body scar 
Adapted from Gowans and Whitehead 
(2001) 

L: 172 
R: 177 

L: 315 
R: 281 

Reclassification (2020) 
L: 58 
R: 61 

L: 241 
R: 240 
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Appendix 5 Protocols used in the compilation of the master catalogue 
A. Film/Negatives and Scanning 

• Most photos from field seasons before 2006 were taken on film and have since 
been scanned as digital copies. The old film negatives are stored in large binders 
in the lab, and each photo is numbered according to the initials of the field 
technician of that year, the roll number and the photo’s position in the roll. For 
example, JA01_18 (from 1999, roll 1, photo 18).  

• The film negatives are very delicate and must be handled with care to protect the 
images, which can be rubbed off. Wear cotton editing gloves when handling and 
only hold by the edges of the strip.  

• Use the light table and magnifying eye piece to view negatives up close. If 
needed, negatives can be scanned into digital copies using the following 
instructions (adapted from protocol by Hillary Moors, September 2011): 
 

1. Plug in the CanoScan 8800F scanner into the computer and ensure the software 
is installed.  

2. Carefully place the film strip(s) in the scanning holder (shiny side down), making 
sure the film is dust free. 

o The film holder has space for 2 film strips, and reads from bottom to top, 
so place the first strip in the bottom row. The film will be read from right to 
left, so make sure the first photo is on the right. Ensure that there is no 
gap between the film strip’s edge on the right and the holder 

3. Close the holder and place in scanner. The white insert in the scanner must be 
removed.  

4. Turn on the scanner, and press PHOTO/FILM to open program automatically, or 
open the image scanning program “MP Navigator”.  

5. Make sure the program has the following settings: 
o Document type: negatives 
o Colour mode: colour 
o Document size: 35mm film 
o Resolution: 1200 dpi (you may need to increase the resolution, however 

the photos will be larger and take longer to scan). 
o Save images as type: JPEG/Exif (do not save over the file, as Jpeg files 

compress when they are saved) 
o Set up automatic naming system: NBWphotos_year_imagename 

6. Select folder to save files.   
7. If desired, preview the photos to ensure orientation and to remove any unwanted 

negatives from being scanned (i.e. water, people, etc.) 
8. Scan. This may take a few minutes depending on the number of photos and the 

resolution. 
9. Remove film from scanner and carefully place in correct row in plastic sheet in 

binder.  
10. Check the save location of the photos and if the file structure is organized 

properly (i.e. by year and photo set). 
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B. Converting CR2 Files to JPEGs 
1. Make sure metadata is saved to photos.  
2. Select photos, then go to File > Export. 
3. On the left sidebar of the pop-up window, select ‘Burn Full-Sized JPEGs’, then in 

the drop-down menu at the top, select Hard Drive.  
4. Use the following settings: 

a. Export Location 
i. Export to ‘Same folder as original photo’ 
ii. Check “Put in subfolder” and name the folder “jpgs” 
iii. Existing files: Ask what to do 

b. File naming 
i. Do not rename photos 

c. Metadata 
i.  Include: ‘All metadata’  
ii. Uncheck ‘Remove person info’ and Remove location info’ 
iii. Check ‘Write keywords as Lightroom hierarchy’ 

5. Click Export. 
6. Synchronize parent folder to import the new jpgs. 
7. Check that the metadata is correct for the jpgs. 
8. On computer, delete or move the CR2 (and xmp sidecar files).  
9. Remove the CR2 files in Lightroom.  
10. In Lightroom, move the jpg photos to the parent folder and delete the ‘jpg’ 

subfolder.  
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C. Changing Capture Date/Time 
• If the date/time of a photo is incorrect, you can go to Metadata > Edit Capture 

Time. This can only be done for 1 photo at a time or for photos with the same 
date/time.  

• For bulk edits of the date/time, you will need to use a program called EXIF Date 
Changer (https://www.relliksoftware.com/exifdatechanger/) in conjunction with 
the List View and Transporter plug-ins (described above). This protocol is a work 
around, so it must be followed exactly so metadata isn’t lost.  

• The program does not work on CR2 files, so these photos will need to be 
converted into JPEGs (see above).  

• You will need an Excel sheet with the original capture date and time for the 
photos. The date and time must be in the following format: YYYY-MM-DD 
HH:MM:SS. Also, ensure that the file name matches what is in Lightroom or the 
process will not work.  
 
1. Make sure the metadata is saved to the photos.  
2. Export a List View of desired photos, then convert to CSV.  
3. In the filename column, find and replace the .jpg of all photos with nothing, 

then Save.  
4. From the List View CSV, use Transporter to import the filename of the photo 

into the Creator field. This will be used later to change the file name back to 
the original name.  

a. You will need to choose “filename w/o extension” as the Lightroom field.  
5. From the sheet with the original capture date/time, use Transporter to import 

the date/time to the Caption of the photo.  
6. Make sure that all photos were successfully modified by Transporter in steps 

3 and 4 before proceeding. Then save the metadata to the photos.  
7. Select photos, and go to Library > Rename Photo, then rename as follows: 

NBW_{Sequence # (1)»}_{Caption»} 
8. In EXIF Date Changer, select source folder with desired photos (or select 

specific photos). The program will automatically create a destination folder 
within the source folder for the adjusted photos.  

9. Check the box for Set date/time from, then select Date in Filename.  
10. Under Options, check the boxes for “Set file created date to taken date” and 

“Use file created date if no date taken”.  
11. Check the “rename files to” box and write “adj-%%f”. This will append to the 

beginning of the filename and will help to keep track of the adjusted photos.  
12. Click Process Photos. When done, click Open Folder the right-click and 

select Properties to check if the date/time was changed correctly.  
13. Import adjusted photos into Lightroom by Synchronizing the parent folder 

containing the adjusted photos. You can also rename the adjusted folder (i.e. 
adj-crops).  

14. Ensure that all metadata has transferred over to adjusted photos, including 
the new information in the Creator field.  

15. Rename photos to have the Creator (i.e. the original filename).  
16. Remove originals from the catalogue.  


